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GRADIENTS

Create and format text

. Flow text into an object

. Position text on a path

. Create colors and gradients

. Apply colors and gradients to text

. Adjust a gradient and create a drop shadow
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GRADIENTS

Working with Text

When it comes to creating compelling and
dramatic display text, no other software
package offers the graphic sophistication
that you'll find with Adobe Illustrator. You
can quickly change fonts, font size, lead-
ing, and other text attributes in the
Character panel. You can make tracking
and kerning measurements with a level of
precision that would satisfy even the most
meticulous typographer. For the designer,
[lustrator is the preeminent choice for
typography. Powerful type tools offer the
ability to fill objects with text, position text
on lines—curved or straight—and set type
vertically, one letter on top of the next.
Once the text is positioned, the Create
Outlines command changes the fonts to
vector graphics that you can manipulate
as you would any other object. For
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example, you can apply a gradient fill to
letter outlines for stunning effects.

Creating and Applying
Gradient Fills

A gradient is a graduated blend between
two or more colors used to fill an object
or multiple objects. Illustrator’s sophisti-
cation for creating gradients and its ease
of use for applying them to objects are a
dream come true for today’s designers.
You can create linear or radial gradients
between multiple colors, then control the
way they fill an object. Moreover, a single
gradient can be used to fill multiple
objects simultaneously! The unique gra-
dient fills that you create can be saved
with descriptive names, then imported
into other Illustrator documents to be
used again.
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What You’ll Do

In this lesson, you will use the Type Tool
to create the word BERRY as display
text. You will use the Character panel

to format the text and perfect its appear-
ance. You will also create a vertical
version of the text.
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FORMAT TEXT

Creating Type

You can create text anywhere on the art-
board simply by selecting the Type Tool
then clicking the artboard to start typing.
You can enter text horizontally or verti-
cally. The ability to type vertically is rather
unusual; most text-based applications
don'’t offer this option.

Text generated by the Type Tool is posi-
tioned on a path called the baseline. You
can select text simply by clicking any-
where on the text. This feature is a prefer-
ence that you can turn on or off: Click Edit
on the menu bar, point to Preferences,
click Type, then remove the check mark in
the Type Object Selection by Path Only
check box, if necessary. When this feature
is checked, you must click the baseline to
select text.

Formatting Text

The Character and Paragraph panels
neatly contain all of the classic commands
for formatting text. Use the Character

panel to modify text attributes such as font
and type size, tracking, and kerning. You
can adjust the leading, which is the verti-
cal space between baselines, or apply a
horizontal or vertical scale, which com-
presses or expands selected type. The
Paragraph panel applies itself to more
global concerns, such as text alignment,
paragraph indents, and vertical spaces
between paragraphs. Figure 1 shows
examples of formatting that you can apply
to text.

Tracking and kerning are essential (and
often overlooked) typographic operations.
Tracking inserts uniform spaces between
characters to affect the width of selected
words or entire blocks of text. Kerning is
used to affect the space between any two
characters; it is particularly useful for
improving the appearance of headlines and
other display text. Positive tracking or
kerning values move characters farther
apart; negative values move them closer
together.
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[lustrator can track and kern type down to
1/1000 of a standard em space. The width of
an em space is dependent on the current
type size. In a 1-point font, the em space is
1 point. In a 10-point font, the em space is
10 points. With kerning units that are 1/,
of an em, Illustrator can manipulate a
10-point font at increments of 1/, of

1 point! Figure 2 shows examples of kerning
and tracking values.

FIGURE 1
Examples of text formatting

Hiding Objects

Two factors contribute to difficulty in
selecting text and other objects: the num-
ber of objects in the document and proxim-
ity of objects. Multiple objects positioned
closely together can make selections diffi-
cult and impede productivity.

Hiding an object is one simple solution.
Hidden objects are safe; they won’t be
deleted from the document when you quit.
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Also, they won't print. Just don’t forget
that they’re there!

The Hide Selection command is under the
Object menu, as is Show All, which
reveals all hidden objects. When hidden
objects are revealed, they are all selected;
you can use this to your advantage.
Simply press [Shift] as you click to dese-
lect the object you want to see, then hide
the remaining objects.

FIGURE 2
Examples of kerning and tracking
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FIGURE 4
Character panel
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Track and kern text

1. Select the text, if necessary.

2. Using the Character panel, click the Tracking
text box, then type -30.
TIP" Click the Character panel list arrow,
then click Show Options, if necessary.
3. Click the Type Tool T, then click the cur-
sor between the B and the E.

4. Using the Character panel, click the up and
down arrows in the Kerning text box to
experiment with higher and lower kerning
values, then change the kerning value to -40.

5. Using Figure 6 as a guide, change the kern-
ing to -20, 0, and -120 between the next
three letter pairs.

6. Click the Selection Tool X , click the
Paragraph panel name tab, then click
the Align center button = | as shown in
Figure 7.
When text is center-aligned, its anchor point
doubles as its center point, which is handy
for aligning it with other objects.
1IP 1f you do not see the Paragraph
panel, click Window on the menu bar, point
to Type, then click Paragraph.
7. Click Object on the menu bar, point to Hide,
then click Selection.

You used the Character panel to change the track-
ing of the word BERRY, then you entered different
kerning values to affect the spacing between the
four letter pairs. You center-aligned the text, then
hid the text.
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FIGURE 6
Kerning and tracking applied to text
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FIGURE 8
Vertical text
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Using the Glyphs panel

The Glyphs panel contains various type characters that aren’t necessarily available on
your keyboard. Examples of these characters include trademarks, copyright marks,
accented letters, and numbers expressed as fractions. Click Window on the menu bar,
point to Type, then click Glyphs to display the Glyphs panel. To access a glyph, click
the Type Tool, click the artboard as you would to type any character, then double-
click the glyph in the Glyph panel that you wish to use.

Lesson 1  Create and Format Text

Create vertical type

1. Click the Vertical Type Tool T , then click
anywhere on the artboard.

[IP" The Vertical Type Tool is hidden
beneath the Type Tool.

2. Type the word BERRY using all capital letters.

TIP The type tools retain the formatting
attributes that were previously chosen.
3. Click the Selection Tool X, select the text,
then move it to the center of the artboard.
TIP" When any tool other than the
Selection Tool is selected in the Tools panel
you can press [Ctrl] (Win) or (Mac) to
switch to the Selection Tool. When you
release [Ctrl] (Win) or (] (Mac), the last
chosen tool will be active again.
4. Using the Character panel, change the font
size to 84 pt.

5. Change the tracking value to -160.

6. Set both the horizontal and vertical scales to
100%, then deselect the text.

Your screen should resemble Figure 8.
7. Delete the vertical text, then save your work.

You used the Vertical Type Tool to create a vertical
alternative to the first word you typed. You
adjusted the tracking and kerning to better suit a
vertical orientation, and then deleted the text.
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What You’ll Do
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In this lesson, you will use the Area Type
Tool to flow text into an object.
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FLOW TEXT INTO

AN OBJECT

o

Filling an Object with Text
Using the Area Type Tool and the Vertical
Area Type Tool, you can flow text into any
shape you can create, from circles to birds
to bumblebees! Text in an object can be
formatted as usual. You can change fonts,
font size, alignment, etc., and the text will
be reflowed in the object as you format it.

When text is flowed into an object, you can
manipulate the object as you would any
other object. Apply fills and strokes and
transformations; use the Rotate Tool, or

the Scale or Reflect Tools. You can even
use the Direct Selection Tool to distort the
shape. Best of all, you can apply those
operations to the text or to the text object
independently! Figure 9 shows an example
of an object, in this case a star, filled with
text.

QUICKTIP

You can underline text and strike through text using the
Underline and Strikethrough buttons on the Character
panel.

Creating Text and Gradients



Locking Objects

Working in tandem with the Hide com-
mand, the Lock Selection command on
the Object menu allows you to exempt an
object from selections and affix its
position on the artboard. The Lock
Selection command is useful simply as a
device to protect objects from accidental
modifications.

Locked objects can be selected only after
they are unlocked by choosing the Unlock
All command on the Object menu. The
Unlock All command unlocks every locked
object on the artboard. When locked
objects are unlocked, they are all selected.
Simply press [Shift] while you click to des-
elect the object you want to work with, and
relock the remaining objects.

Using Rulers, Guides,

and the Grid

[llustrator has two built-in rulers that run
along the top and left side of the docu-
ment window. You can create ruler guides
and place them on the artboard by posi-
tioning the mouse pointer in the top or
left ruler, then dragging the mouse
pointer onto the artboard. As you drag,
you'll see a guide emerge and when you
release the mouse pointer, the guide will
be positioned at that point. To view rulers,
click View on the menu bar, then click
Show Rulers. You can lock guides and
hide guides temporarily as you work in
[lustrator. Click View on the menu bar,

Lesson 2 Flow Text into an Object

point to Guides and you will see all of the
Guide menu commands.

Another tool for aligning objects on the
artboard is to use the grid. Grid settings are
defined in the Guides & Grid section of the
Preferences dialog box. You can choose a
color and style for the grid, choose the dis-
tance between gridlines and how many
subdivisions between gridlines. To hide and
show the grid, click View on the menu bar,
then click Hide Grid or Show Grid.

FIGURE 9
An object filled with text

Making Guides

Guides are one of Illustrator’s many fea-
tures that help you to work with precision.
You can select any object and make it into a
guide with the Make Guides command on
the View menu. You can also create guides
by clicking and dragging the mouse pointer
from each ruler to the artboard.
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RS Aoplying the Area Type Tool

1. Open Al 2-2.ai, then save it as } B e
Diamond Text. A S Click rﬁe edge of
g s the object with the

2. Select the yellow square, double-click the / : Arod 76 Taol
Rotate Tool ., type 45 in the Angle text :
box, then click OK.

3. Click the Area Type Tool {TJ, then click the N The Area Type

Tool converts an

block of text. o
% o object into a
1IP" The Area Type Tool is hidden beneath ; f container for text
the current type tool.

4. Click Select on the menu bar, then click All.

TIP" When you click a type tool cursor on
text and apply the Select All command, all
the text is selected—not the object that con-
tains the text, and not any other text or
objects on the page.

5. Copy the text.

6. Click the Selection Tool X , select the yel-
low square, then change the font size to 12
using the Character panel.

FIGURE 11
Text pasted into an object
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A flashing cursor appears, and the square z.boyscn checker cran rasp boysen blue
loses its fill color, as shown in Figure 10. \\"\black rasp straw blue black straw
8. Paste the copied text into the square. tea boysen checker cran rasp//
Your work should resemble Figure 11. “straw blue tea black ) /
You rotated the yellow square, then filled it with Indicates \rasp straw blue
text by first copying text from another object, then overdlow text “~«~;b\lack straw
clicking the edge of the square with the Area Type ~X
Tool before you pasted the text into the square. b '
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FIGURE 12
Centered text in an object
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Using Character and Paragraph Styles

A style is a group of formatting attributes, such as font, font size, color, and tracking,
that is applied to text. You use the Character Styles panel to create and apply styles
for individual words or characters, such as a footnote. You use the Paragraph Styles
panel to apply a style to a paragraph. Paragraph styles include formatting options
such as indents and drop caps. Using styles saves you time, and it keeps your work
consistent. If you create styles for an Illustrator document, the styles are saved with
the document and are available to be loaded for use in other documents.

Lesson 2 Flow Text into an Object




FIGURE 13
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FIGURE 14
Guides & Grid Preferences settings
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What You’ll Do
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@ In this lesson, you will explore the many
options for positioning text on a path.

ILLUSTRATOR 2-16

ON A PATH

Using the Path Type Tools
Using the Type on a Path Tool or the
Vertical Type on a Path Tool, you can type
along a straight or curved path. This is the
most compelling of Illustrator’s text
effects, and it opens up a world of possibil-
ities for the designer and typographer.

You can move text along a path to position
it where you want. You can “flip” the text
to make it run in the opposite direction—
on the opposite side of the path. You can

also change the baseline shift to modify
the distance of the text’s baseline in rela-
tion to the path. A positive value “floats”
the text above the path, and a negative
value moves the text below the path. You
can modify text on a path in the same way
you would modify any other text element.
Figure 15 shows an example of text on a
path, whereas Figure 16 shows an example
of text flipped across a path.
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FIGURE 15
Text on a path

FIGURE 16
Text flipped across a path
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Flow text on a path

1. Click the Ellipse Tool ., press [Alf] (Win)
or [option] (Mac), then click the center of the
artboard.

Pressing [Alt] (Win) or [option] (Mac) while
you click a shape tool on the artboard
ensures that the center of the shape will be
drawn from the point that you clicked.

2. Enter 2.9 in for the width and the height of the
circle in the Ellipse dialog box, then click OK.

3. Click the Type on a Path Tool ~¢" , then click
anywhere on the edge of the circle.

TIP The Type on a Path Tool may be hidden
beneath the current type tool.
A flashing cursor appears, and the circle
loses its fill color.

4. Type three rivers in lowercase, using Times
New Roman PS MT for the font.

TIP" If you do not have Times New Roman
PS MT, substitute a similar font.

5. Click the Selection Tool ﬂ to select the text by
its baseline, then change the font size to 47 pt.
You will see three brackets—one at the begin-
ning of the path, one at the end of the path,
and one at the midpoint between the two
brackets. These brackets allow you to move
text along a path.

TIP Text flowed on a circle will often

require kerning, especially when it is set at a
large point size.

6. Compare your screen to Figure 17.

You created a 2.9" circle from its center, then
typed along the circle’s path using the Type on a
Path Tool. You changed the font and font size
using the Character panel.
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FIGURE 17

Text on a circular path
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FIGURE 18
Moving text on a path
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FIGURE 19
Flipping text across a path
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FIGURE 21
Flipped text positioned below the path
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Move text along a path

1.

2.

7.

9.

Click View on the menu bar, point to
Guides, then click Hide Guides.

Using the Selection Tool X, drag the
center bracket until the text is centered at
the top of the circle.

Click Edit on the menu bar, click Copy, click
Edit on the menu bar, then click Paste in Front.

Drag the center bracket of the copied text
clockwise to move the copied text to the
position shown in Figure 18.

Drag the center bracket of the copied text
straight up to flip the text across the path, as
shown in Figure 19.
TIP Enlarge your view of the artboard if you
have trouble dragging the bracket.
Click the Baseline text box in the Character
panel, type -21, as shown in Figure 20, then
press [Enter] (Win) or [return] (Mac).
Click the Type Tool T.), highlight three
rivers at the bottom of the circle, then type
symposium.
Click the Selection Tool X , then drag the
center bracket to center the text at the bot-
tom of the circle, if necessary.

Lock the two text objects, save your work,
then compare your image to Figure 21.

You moved and copied text along a path, flipped
its direction, changed the baseline shift, then
locked both text objects.
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What You’ll Do

In this lesson, you will use the Color panel,
the Gradient panel, and the Swatches
panel to create, name, and save colors
and gradients.
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GRADIENTS

Using the Gradient Panel

A gradient is a graduated blend between
colors. The Gradient panel is the com-
mand center for creating and adjusting
gradients. In the panel you will see a slider
that represents the gradient you are creat-
ing or working with. The slider has at least
two colors. The leftmost color is the start-
ing color, and the rightmost color is the
ending color.

The colors used in a gradient are repre-
sented in the Gradient panel by small
house-shaped icons called stops. The
Gradient panel shown in Figure 22 shows
a two-color gradient.

The point at which two colors meet in
equal measure is called the midpoint of
the gradient. The midpoint is represented
by the diamond above the slider, which is
called the Gradient Slider. The midpoint
does not necessarily need to be positioned
evenly between the starting and ending
colors. You can change the look of a gradi-
ent by moving the Gradient Slider to
change the location of the midpoint.

The Swatches panel contains standard gradi-
ents that come with the software. To create
your own original gradients, start by clicking
an object filled with an existing gradient.
You can then modify that existing gradient
in the Gradient panel. You can change either
or both the beginning and ending colors.
You can change the location of the midpoint.
You can also add additional colors into the
gradient, or remove existing colors.

TIP
As you work to perfect a gradient, you can see how your
changes will affect the gradient automatically, by filling an
object with the gradient that you are working on. As you
make changes in the Gradient panel, the changes will be
reflected in the object.

You can define a gradient as linear or
radial. A linear gradient can be positioned
left to right, up and down, or on any angle.
You can change the angle of the gradient
by entering a new value in the Angle text
box in the Gradient panel.
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Think of a radial gradient as a series of con-
centric circles. With a radial gradient, the
starting color appears at the center of the
gradient. The blend radiates out to the end-
ing color. By definition, a radial gradient
has no angle ascribed to it.

Using the Color Panel

The Color panel, as shown in Figure 23, is
where you move sliders to mix new colors
for fills, strokes, and gradients. You can also
use the panel to adjust the color in a filled
object. The panel has five color modes:
CMYK, RGB, Grayscale, HSB, and Web Safe
RGB. The panel will default to CMYK or
RGB, depending on the color mode you
choose when creating a new document.
Grayscale mode allows you to create shades

of gray in percentages of black. If you select
a filled object and choose the HSB mode,
you can adjust its basic color (hue), the
intensity of the color (saturation), and the
range of the color from light to dark (bright-
ness). If you are designing illustrations for
the Internet, you might consider using Web
Safe RGB mode to create colors that are in
accordance with colors defined in HTML.

Rather than use the sliders, you can also
type values directly into the text boxes. For
example, in CMYK mode, a standard red
color is composed of 100% Magenta and
100% Yellow. The notation for this callout
would be 100M/100Y. Note that you don’t list
the zero values for Cyan (C) and Black (K). In
RGB mode (0-255), a standard orange color
would be noted as 255R/128G.

FIGURE 22
Gradient panel
Type list =T
arrow
Gradient Location Current fil
Fill box text box and stroke
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Angle Gradient Slider
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Adding Colors and Gradients to
the Swatches Panel

Once you have defined a color or a gradient
to your liking, it’s a smart idea to save it by
dragging it into the Swatches panel. Once a
color or gradient is moved into the
Swatches panel, you can name it by double-
clicking it, then typing a name in the
Swatch Options dialog box. You can’t, how-
ever, modify it. For example, if you click a
saved gradient and adjust it in the Gradient
panel, you can apply the new gradient to an
object, but the original gradient in the
Swatches panel remains unaffected. You
can save the new gradient to the Swatches
panel for future use.

FIGURE 23
Color panel

CMYK color
values

Lesson 4  Create Colors and Gradients
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7.

10

11.

Show the guides.

Create a 4" circle at the center of the art-
board, then apply a yellow fill to the circle.
The most recently drawn object is automatically
placed above the other objects on the artboard.
Hide the guides, click Window on the menu bar,
then click Gradient to select it, if necessary.
Click Window on the menu bar, then

click Color to select it, if necessary.

Click the Blended Rainbow swatch in the
Swatches panel.

The yellow fill changes to the Blended
Rainbow fill.

Click the Gradient panel list arrow, then
click Show Options, if necessary.

Click the yellow stop on the Gradient Slider, and
drag it straight down off the panel to delete it.
Delete all the stops except for the first and
last stops.

TP The changes you make to the Gradient
Slider are reflected in the circle.
Click the bottom edge of the Gradient Slider to
add a new color stop, then drag the stop along
the slider until you see 50% in the Location text
box in the Gradient panel as shown in Figure 24.
Drag each Gradient Slider to the 50% mark
in the Location text box.
Verify that the new stop is selected, press
and hold [Alt] (Win) or [option] (Mac), click
Squash in the Swatches panel, then com-
pare your circle to Figure 25.

(continued)
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FIGURE 24
Adding and deleting stops

| ¢ cradientx |

Gradient
Sliders

I BN

Click bottom Drag stop along the
edge of slider to slider to position it
add a new stop at a new location

FIGURE 25
The color Squash is added to the gradient
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FIGURE 26 You must select a stop in order to change
Black starting and ending colors its color.
1IPIf you don’t press [Alt] (Win) or
[option] (Mac), as you choose a swatch
for your gradient, you will change the
selected object’s fill to a solid color.

11. Click the first stop on the Gradient Slider,
press [Alt] (Win) or [eption] (Mac), then
click Black on the Swatches panel.

12. Repeat Step 11 to apply Black to the third
stop, then compare your circle to Figure 26.

13. Click the Squash stop to select it, then drag
each slider in the Color panel until the new
CMYK values are 5C/95M/95Y/3K.

TP Expand the view of the Color panel,
if necessary.

14. Click the Type list arrow in the Gradient
panel, then click Radial.
15. Click the diamond at the top of the Gradient

Slider between the first two stops, then
drag it to the 87% location on the slider.

FIGURE 27
Changing the location of the midpoint of two colors

16. Compare your circle to Figure 27.

You applied the Blended Rainbow gradient to the
yellow circle. You created a new gradient by delet-
ing the four intermediary stops and adding a new
stop to the gradient. You changed the gradient
from linear to radial, then adjusted the midpoint of
the blend between the starting color and the red
intermediate color.
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1.

Add gradients and colors to
the Swatches panel

Double-click the Scale Tool ., type 65 in
the Scale text box, then click Copy.
Keeping the smaller circle selected, delete

the red stop on the Gradient Slider in the
Gradient panel.

Change the first stop starting color to White
and the ending stop to 0C/40M/50Y/0K.
| TIP Press [Alt] (Win) or [option] (Mac).

When a stop is selected on the Gradient
Slider, the color of that stop appears in the
Gradient Stop Color box in the Color panel.

Position the midpoint on the Gradient Slider
at 65%.

Your screen should resemble Figure 28.

Drag the Gradient Fill box from the Gradient
panel to the Swatches panel, as shown in
Figure 29.

Double-click New Gradient Swatch 1 (the gra-
dient you just added) in the Swatches panel to
open the Swatch Options dialog box.

Type Pinky in the Swatch Name text box,
then click OK.

Click the last color stop on the
Gradient Slider.

(continued)
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FIGURE 28
A radial gradient with white as the starting color

| Swatches x |

FIGURE 29
Adding a gradient to the Swatches panel

| ¢ Gradient x |

Type: Radial -

_
Drag Gradient Fill box
fo Swatches panel

(v, [

radient Fill box
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9. Drag the Gradient Stop Color hox from the
Color panel to the Swatches panel to add
this color to the Swatches panel, as shown
in Figure 30.

10.Click the Selection Tool X .

11.Click the artboard to deselect the

FIGURE 30 smaller circle.
Adding a gradient to the Swatches panel 12.Name the new color swatch Pinky Ending,
then click OK.

13.Click the large circle, drag the Gradient Fill
box in the Gradient panel to the Swatches
panel, then name the new gradient Crimson
Gradient.

14.Save your work.

j Sweatches [

B . i
N B

* 7 F

You used the Gradient panel to create a new gradi-

1™ ———— ent. You added the gradient fills from the two cir-

cles to the Swatches panel and gave them

- X descriptive names. You added a color named Pinky
‘ , = Ending to the Swatches panel then created a new
gfalg bead/t@m Stop (G:fa/dlé’gf Stop & [ rerraaas gradient called Crimson Gradient.
olor box to olor box )
Swatches panel e ° Location: 100 9%
t2
[ )
0 o
When a stop is selected,
the color appears in the
Gradient Stop Color box

in the Color panel
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What You’ll Do

In this lesson, you will apply colors to text,
convert text into objects, and fill the
objects with a gradient.

ILLUSTRATOR 2-26

GRADIENTS TO TEXT

Applying Fills and Strokes

to Text

Regardless of the fill and stroke colors
shown in the Tools panel new text is gen-
erated by default with a black fill and no
stroke. To change the color of text, you
must either select the text by highlighting
it with a type tool, or switch to a selection
tool. When you switch to a selection tool,
the text is selected as a single object (a
blue baseline and anchor point are
revealed). Any color changes you make
will affect the text globally. If you want to

Working with the stacking order

change the fill or the stroke of an individ-
ual character, you must select that charac-
ter with a type tool.

Converting Text to Outlines
About the only thing you can’t do to
Ilustrator text is fill it with a gradient. To
create the effect, you first need to convert
the text into objects. You can do this by
selecting the text, then using the Create
Outlines command on the Type menu. The
letterforms, or outlines, become standard
[llustrator objects with anchor points and

The stacking order defines how objects will be displayed when they overlap.
Illustrator stacks each object. Beginning with the first object, each successive object
you create overlaps the previously drawn objects. You can change the stacking order
by moving objects forward and backward through the stack, one object at a time. You
can also move an object to the very top or the very bottom of the stack with one com-
mand. Grouped objects are stacked together behind the top object in the group. If
you group two objects that are separated in the stack, the objects in between will be

positioned behind the new group.
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paths able to be modified like any other
object—and able to be filled with a gradi-
ent. Figure 31 shows an example of text
converted to outlines.

Create Outlines is a powerful feature. Beyond
allowing you to fill text with a gradient, it
makes it possible to create a document with

Lesson 5 Apply Colors and Gradients to Text

text and without fonts. This can save you
time in document management when send-
ing files to your printer, and will circumvent
potential problems with missing fonts or
font conflicts.

Once text is converted to outlines, you can
no longer change the typeface. Also, the

FIGURE 31
Text converted fo outlines

type loses its font information, including
sizing “hints” that optimize letter shape at
different sizes. Therefore, if you plan to
scale type, change its font size in the
Character panel before converting to out-
lines.
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Apply color to text

. Select the two circles, click Object on the

menu bar, point to Arrange, then click Send
to Back.

The two circles move behind the locked
text objects.

Click Object on the menu bar, then click
Unlock All.

The three text objects you created and
locked are now unlocked and selected.

Apply the Pinky Ending color as a fill for the
three unlocked text objects.

Deselect all, then lock the diamond
text object.

Your work should resemble Figure 32.

You unlocked the three text objects, filled them
with the Pinky Ending color, then locked the
diamond text object.

Importing a swatch library

FIGURE 32
Text with a new fill color

Swatches and gradients that you create are saved with the document they were cre-
ated in. You can, however, import swatches from one document into another. Click
Window on the menu bar, point to Swatch Libraries, then click Other Library. A dia-
log box opens allowing you to choose the document whose swatches you want to
import. Click Open, and that document’s Swatches panel will appear in your current
document. When you import a Swatches panel, the panel automatically appears with
the name of the document from which it came. The imported Swatches panel is not
editable—you cannot add new swatches to it or delete existing ones from it.

ILLUSTRATOR 2-28

Creating Text and Gradients



Create outlines and apply a
gradient fill

1. Show the guides.

2. Click Object on the menu bar, then click
Show All.

3. Select the BERRY text, click Object on the
menu bar, point to Arrange, then click Bring

FIGHRBE 53 to Front.

Outlines filled with a gradient
4. Click Type on the menu bar, then click

Create Outlines.

5. Apply the Steel gradient in the Swatches
panel to fill the text outlines, then deselect
the outlines.

6. Using Figure 33 as a guide, position the

g ext outlines so that they are cen-
y BERRY text outli that th
tered within the entire illustration, then hide
the guides.

7. Save your work.

You showed the BERRY text, moved it to the front,

converted it to outlines, then filled the outlines

with a gradient.

Each outline is filled
with the gradient
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What You’ll Do

\ In this lesson, you will use the Gradient
Tool to modify how the gradient fills the
outlines. You will then explore the effec-
tiveness of a simple drop shadow as a
design element.
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CREATE A DROP SHADOW

Using the Gradient Tool

The Gradient Tool is used to manipulate
gradient fills that are already applied to
objects; it affects only the way a gradient
fills an object. To use the tool, you first
select an object with a gradient fill. You
then drag the Gradient Tool over the
object. For both linear and radial gradi-
ents, where you begin dragging and where
you end dragging determine the length of
the blend from starting to ending color.
For linear gradients, the angle that you
drag in determines the angle at which the

blend fills the object. If you apply the same
gradient to multiple objects, you can
select all the objects and use the Gradient
Tool to extend a single gradient across all
of them.

If you select and fill multiple objects with
a gradient, each object is filled with the
entire length of the gradient, from begin-
ning color to ending color.

When you convert text to outlines and
apply a gradient fill, the gradient automat-
ically fills each letter independently. In
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other words, if you fill a five-letter word
with a rainbow gradient, each of the five
letters will contain the entire spectrum of
colors in the gradient. To extend the gradi-
ent across all the letters, drag the Gradient
Tool from the left edge of the word to the
right edge. Figure 34 shows examples of
different angles and lengths of a gradient
fill created with the Gradient Tool.

FIGURE 34
Using the Gradient Tool

(ol

NI

Adding a Drop Shadow

Applying a shadow behind text is an effec-
tive design tool to distinguish the text
from other objects and add dimension to
the illustration. To apply a drop shadow to
text, copy the text, then paste the copy
behind it. Fill the copy with a darker color,
then use the keyboard arrows to move it so
that it is offset from the original text. See
Figure 35.

QUICKTIP

When adding subtle design effects to objects, you
may want to work without seeing the anchor
points and paths on selected items. You can hide
them by using the Hide Edges command on the
View menu. Hiding edges allows you to work on
an object without the distraction of the points
and paths.

FIGURE 35

Drop shadow created using the Paste in Back command

G/ ADIENT

RADIENT
GRADIENT
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Use the Gradient Tool FIGURE 36
Gradient Tool applied top to bottom

1. Select the BERRY text outlines, if necessary.

2. Click the Gradient Tool (& then position
the pointer at the top of the B.

3. Drag straight down to the bottom of the B,
then release the mouse.

Your work should resemble Figure 36.

TIP Pressing and holding [Shift] while
you drag the Gradient Tool pointer allows
you to drag in a perfectly straight line.
4. Switch to the Selection Tool X, then click
the large circle filled with the Crimson
Gradient fill behind the text.

5. In the Gradient panel, reposition the red
center color stop so that the value in the
Location text box reads 82%.

The red stop in the blend is now positioned
behind the three rivers and symposium text,

as shown in Figure 37.
2 ; FIGURE 37
You used the Gradient Tool to flow the gradient A highlight behind the text

from top to bottom in the word BERRY. You
adjusted the red stop in the Gradient panel to
move the red highlight behind the three rivers and

; Red stop in a
symposium text. p

radial gradient
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FIGURE 38 FIGURE 39
Drop shadow with a 3 pt offset Drop shadows add dimension

Drop shadow added
to symposium

FIGURE 40
The finished illustration

Lesson 6 Adjust a Gradient and Create a Drop Shadow

Add a drop shadow to text

o

Select the word BERRY.

Apply a 1 pt Black stroke to the outlines.
Copy the word, then paste in back.

Change the fill of the copied object to Black.

[P Even though you can't see the copy

of the text in back, it is still selected.
Press \ three times and € three times to
move the copied text 3 pts down and 3 pts to
the left, as shown in Figure 38.

6. Copy the word symposium, then paste in back.

10.

11

12.

Change the fill of the copied text to Black.

[P Since the copy is still selected, you only

need to click Black in the Swatches panel.
Using the arrow keys, move the copied text 2 pts
down and 2 pts to the left, as shown in Figure 39.

Apply the same drop shadow to the three
rivers text.
TIP You might find it easier to select the

three rivers text if you first lock the sympo-
sium text and the symposium shadow text.

Unlock all, select everything on the artboard,
then rotate the illustration 15°.

.Click the Selection Tool X, then click the

arthoard to deselect all.
Your work should resemble Figure 40.

Save your work, then close and save each
document.

You applied a black stroke to the display text and then
pasted a copy behind. You filled the copy with black,
then offset the copy to create a drop shadow effect.
You then applied a drop shadow to symposium and
three rivers. Finally, you rotated the entire illustration.
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Create and format text.

1=

1=
8.

Open Al 2-3.ai, then save it as Restaurant
Logo.

Using a bold font, type NOW OPEN on two
lines, using all capital letters. (Hint: The font
used in Figure 41 is Impact.)

Change the font size to 29 pt and the leading
to 25 pt.

Change the baseline shift to 0.

Change the alignment to center and the
horizontal scale to 75%.

Position the text in the center of the

white circle.

Hide the text.

Save your work.

Flow text into an object.

e
2.
3.

Copy the beige circle.

Paste the copy in front of it.

Click the Type Tool, then select all of the
green text at the bottom of the artboard,
with the Type Tool.

Copy the green text.

Click the Selection Tool, then click the top
beige circle.

Click the Area Type Tool, click the edge of
the top beige circle, then paste.
Center-align the text in the circle.

Change the baseline shift to -4 pts.

Fill the selected text with the same fill color
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10.

1.
12.

as the beige circle (50% Orange).

In the Color panel, drag the Magenta slider
to 40% to darken the text.

Hide the text.

Save your work.

Position text on a path.

1.
2.

Select the dark gray circle.

Click the Type on a Path Tool, then click the
top of the circle.

Using a bold font, type THE HOLE-IN-ONE in
all capital letters across the top of the circle.
(Hint: The font in Figure 41 is Techno
Regular. If your type appears at the bottom
of the circle, drag the start or end bracket to
position the type at the top of the circle.
Zoom in so that you can clearly see the
brackets. If you move the circle instead of
the type, undo your last step and try again.)
Change the font size to 34 pt and the fill
color to white. (Hint: You may need to use a
smaller font size, depending on the font you
choose.)

Click the Selection Tool, click Edit on the
menu bar, click Copy, click Edit on the menu
bar, click Paste in Front, then move the cen-
ter bracket clockwise to position the copied
text across the bottom of the circle.
Highlight the copied text, then type
RESTAURANT & BAR with the Type Tool.

7. Drag the RESTAURANT & BAR text across
the path to flip its direction.

8. Apply a negative baseline shift to move the
text below the path. (Hint: The baseline shift
used in Figure 41 is -27 pts.)

9. Copy both text objects, then paste them
in back.

10. Fill the back copies of the text with
black, then move them 2 pts up and 2 pts
to the right.

11. Save your work.

Create and apply gradient fills

to objects.

1. Apply the White, Black Radial gradient to the

=

small white circle.

Change the ending color stop on the
Gradient panel to Smoke. (Hint: Press [Alt]
(Win) or [option] (Mac) while you select
Smoke from the Swatches panel.)

Save the new gradient in the Swatches
panel.

Name it Golf Ball.

Fill the large green circle with the Golf Ball
gradient.

Change the starting color stop to Pure Yellow.
Change the ending color stop to Little
Sprout Green.
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SKILLS REVIEW (CONTINUED)

8. Move the midpoint of the two colors to the FIGURE 41

80% location on the Gradient Slider. Completed Skills Review
9. Save the new gradient as The Rough.
10. Save your work.

Adjust a gradient and create a drop
shadow.

1. Click Object on the menu bar, then click
Show All.

2. Deselect all by clicking the artboard.

3. Select NOW OPEN and convert the text to
outlines. (Hint: Use the Type menu.)

4. Fill the text with the White, Black gradient.

5. Change the starting color stop to black.

6. Create an intermediary white color stop at
the 50% mark on the Gradient Slider.

7. Drag the Gradient Tool starting at the top
of the word NOW to the bottom of the
word OPEN.

8. Change the middle color stop of the gradient
to Latte.

9. Save the new gradient as Flash.

10. Deselect the text.

11. Delete the green text from the bottom of the
artboard.

12. Convert the remaining text objects into
outlines.

13. Select all, then lock all objects.

14. Save your work, compare your illustration to
Figure 41, then close Restaurant Logo.
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An eccentric California real-estate
mogul hires your design firm to “create
an identity” for La Mirage, his develop-
ment of high-tech executive condomini-
ums in Palm Springs. Since he’s curious
about what you’ll come up with on your
own, the only creative direction he’ll
give you is to tell you that the concept is
“a desert oasis.”

1.

10.

11.

Create a new 6" x 6" CMYK Color document,
then save it as Desert Oasis.

Using a bold font and 80 pt for a font size,
type LA MIRAGE in all capitals. (Hint: The
font shown in Figure 42 is Impact.)

Change the horizontal scale to 80%.
Change the baseline shift to 0.

Apply a -100 kerning value between the
two words.

Convert the text to outlines, then click the
Linear Gradient 1 gradient in the Swatches
panel.

Using the Color panel, change the first color
stop to 66M/100Y/10K (Hint: Press and hold
[Alt] (Win) or [option] (Mac) when creating
the new color.)

Create an intermediary color stop that is
25M/100Y.

Position the intermediary color stop at 70%
on the slider.

Save the gradient in the Swatches panel,
and name it Desert Sun.

Drag the Gradient Tool from the exact top to
the exact bottom of the text.
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12. Create a rectangle around the text and fill it
with the Desert Sun gradient.

13. Drag the Gradient Tool from the bottom to
the top of the rectangle.

14. Send the rectangle to the back of the stack.

FIGURE 42
Completed Project Builder 1

15.
16.

17.

18.

Apply a 1-point black stroke to LA MIRAGE.
Type the tagline: a desert oasis in 14 pt
lowercase letters.

Apply a tracking value of 500 or more to the
tagline, then convert it to outlines.

Save your work, then close Desert Oasis.
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Your friend owns Loon’s Balloons. She 12. Move the headline LOON’S BALLOONS so 13. Apply a 320 kerning value between the

stops by your studio with a display ad that that each word is on a different side of the two words.
she’s put together for a local magazine balloon string. 14. Save your work, compare your screen to
and asks if you can make all the elements Figure 43, then close Balloons.

work together better. Her only direction
is that the balloon must remain pink, the
same color as her logo.

FIGURE 43
Completed Project Builder 2

1. Open Al 2-4.ai, then save it as Balloons.

2. Save the pink fill on the balloon to the
Swatches panel, and name it Hot Pink.

3. Fill the balloon shape with the White,

Black Radial gradient from the Swatches
panel.

4. Change the black stop on the Gradient Slider
to Hot Pink.

5. Using the Gradient Tool, change the high-
light point on the balloon shape so that it is
no longer centered in the balloon shape.

6. Copy the balloon, then paste it in front.

7. Click the Selection Tool on the block of text
that says “specializing in etc.”, then cut
the text.

8. Click the top balloon with the Selection Tool,
thfen switch to the Area Type Tool. LOON' S BALLOON S

9. Click the top edge of the top balloon, then
paste.

10. Center the text and apply a -4 baseline shift.

11. Adjust the layout of the text as necessary.

(Hint: You can force a line of text to the next
line by clicking before the first word in the
line you want to move, then pressing
[Shift][Enter] (Win) or [Shift][return] (Mac).)
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You work in the marketing department of
a major movie studio, where you design
movie posters and newspaper campaigns.
You are respected for your proficiency
with typography. Your boss asks you to
come up with a “teaser” campaign for the
movie Vanishing Point, a spy thriller. The
campaign will run on billboards in 10 major
cities and will feature only the movie title,
nothing else.

1. Create a new 6" x 6" CMYK Color document,
then save it as Vanish.

2. Type VANISHING POINT, using 100 pt
and a bold font. (Hint: The font used in
Figure 44 is Impact.)

3. Change the horizontal scale to 55%.

4. Convert the text to outlines.

5. In the Swatches panel, click the Linear
Gradient 1 gradient.

6. Drag the Gradient Tool from the exact bot-
tom to the exact top of the letters.

7. Copy the letters, then paste them in front.

Fill the copied letters in front with white.

9. Using your arrow keys, move the white let-
ters 2 pts to the left and 8 pts up.

10. Save your work, then compare your text
with Figure 44.

11. Close Vanish.

L
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FIGURE 44
Completed Design Project
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Firehouse Chili Pepper Company, a local
specialty food manufacturer, has hired
your team to design a label for its new
line of hot sauces. Since this is a new
product line, they have no existing mate-
rials for your team to start from.

1. Create a new 6" x 6" CMYK Color document,
then save it as Firehouse Chili.

2. Assign two team members to search the
Internet to get design ideas. They should
use keywords such as chili, pepper, hot
sauce, barbecue, and salsa. What have other
designers created to convey these con-
cepts? Is there a broad range of ideas, or
are they all pretty much different versions of
the same idea? If so, can your group think
of something original that works?

3. Assign two other members to go to the gro-
cery store and return with some samples of
other products in this niche. Be sure they
purchase both products that you've heard of
before and products you've never heard of
before. Are the known products’ design con-
cepts better than the unknown products’?
Have the group discuss any correlation
between the successful products and better
design, if it is evident.

4. Two other team members should be in
charge of typographic research and should
work closely with the design team. Again,
have the group discuss whether it sees a
variety of typefaces used in relation with this
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concept, or whether they are all pretty much
the same. 5
While everyone else is researching, the
design team should begin brainstorming
and sketching out ideas. Although there are
no existing materials, the product line’s
name is very evocative. The team should
create design ideas that spring from the
concepts of “firehouse” and “chili pepper,”
as well as from more broad-bhased concepts
such as salsa, Mexico, and fire.

FIGURE 45
Completed Group Project

6.

Use the skills that you learned in this chap-
ter to create the label. (Hint: Fill text out-
lines with a gradient that conveys “hot.”
Use reds, oranges, and blacks. Use a bold
font for the text so that the gradient will be
clearly visible. Position the stops on the
slider so that the “hot” colors are promi-
nent in the letterforms.)

Save your work, then compare your results
with Figure 45.

Close Firehouse Chili.
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